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SECTION 1 - INTRODUCTION 

 
The program complex "Internet Administrator" is designed for the full and all-round 

control of Internet access at the enterprise. The complex provides monitoring users access to 
the Internet, limits resources of users and access to Internet resources. 

Monitoring users access provides the information on how the Internet at the enterprise 
is used, namely: all information about the access (Who, When, Where and How), how long 
the user stayed on the given resource, how much data was downloaded and sent. 

User resources include: the incoming traffic, time spent in the Internet, and the 
bandwidth, i.e. the speed with which the user downloads data from the Internet. The traffic 
and the time are supervised as value of the spent size for a certain period of time. Bandwidth 
is set as the speed of data transmission - maximal and guaranteed. 

Internet resources include: web sites categories, domains, single sites, subnets, 
protocols, time of access, URL inquiries. The access policy is realized on the basis of a 
flexible system of access rules. The access policy defines Who, When, Where and How can 
get access. The availability of the base of sites divided into categories allows flexible 
operation of the Internet access. 

The "Internet Administrator" supports various types of users identification on 
workstations. This can be a static binding of the user to a workstation, the user will be 
associate with a workstation after a logon into the Windows Active Directory, or the user will 
have to enter his own name and password. Last two methods of identification are applied in 
case the users have no permanent workstations, and also if a DHCP server with dynamic 
distribution of IP addresses is installed in the network. 

“Internet Administrator" works on the popular Windows platform that permits to apply 
this system in various corporate networks. Unlike systems of a proxy servers and firewalls, 
the “Internet Administrator" is based on the technology of interception of network packages. It 
allows installing the system on any computer inside the network segment. In case if switches 
are used in a network, the connection of a monitored port on that switch where the computer 
with the installed “Internet Administrator" complex is connected to is necessary. 

“Internet Administrator" includes more than 10 reports visually showing the character of 
use of corporate Internet access. Reports can be printed, saved, converted to a number of 
popular formats. 

“Internet Administrator" consists in two basic components - the Server and the Client. 
The server carries out the basic part of the tasks connected with the access control. The 
client is an additional module which is installed on workstations. The client is necessary for 
the following functions: bandwidth control, show of user statistics, user identification. 
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SECTION 2 - INSTALLATION 
 
Section 2.1. - System requirements 
 
Hardware-software System requirements of the “Internet Administrator" complex: 
 
Internet Administrator, the server 
 
Operation system: Microsoft Windows 2000 Professional SP3 
Microsoft Windows 2000 Server SP3 
Microsoft Windows 2000 Advanced Server SP3 
Microsoft Windows 2003 Server 
Microsoft Windows XP 
 
 
CPU: Pentium or CELERON class with a frequency of 1000 Megahertz or more 
   
Memory: 512 Mb, 1024 Mb and more is recommended 
   
Disk space: 1000 Mb 
   
Network card: Ethernet network adapter supporting promiscuous mode 
 
 
Internet Administrator, the client 
 
OS: Microsoft Windows 98 (updating DCOM 1.3 or above is required) 
Microsoft Windows 2000 Professional 
Microsoft Windows XP 
Other system requirements are defined by the requirements of operation system. 
 
Section 2.2. - Preparation for installation 
 
The location of a computer with the "Internet Administrator" in a network is important. Since 
the principle of work of a complex is based on the interception of network packages, the 
installation has to be carried out on a computer located in that segment of a network where all 
traffic from workstations to the Internet passes. Here are the variants of a correct location 
choice. 
 
Variant 1. 

 
In this variant a simple network with a hub and a hardware router is presented. With such 
scheme the installation can be done on any computer in the segment. 
 

http://www.iadmin.biz
mailto:sales@iadmin.biz


Internet Administrator, version 2.6 
 

Copyright  2003 Internet Administrator Company Ltd. 
http://www.iadmin.biz, e-mail: sales@iadmin.biz 

 - 5 - 

 Variant 2. 

 
If workstations are connected to the Internet through the proxy server or network address 
translator (NAT) on the Windows platform, the installation can be done on this computer. 
 

Variant 3. 

 
In this variant a complex network with a simple network switch is presented. The computer 
with the “Internet Administrator" will need to be connected through a hub to one segment with 
a target router and the switch. 
 

Variant 4. 

 
A complex network with a smart switch is presented. The smart switch can be adjusted so 
that it could send all data to a special mirror port (monitoring or spanning). Connect the 
computer with the “Internet Administrator” to this port. 
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Note. The majority of current small networks are connected by providers using the third 
variant. Introduction of a hub is sometimes problematic, therefore variant 3 can be 
transformed easily into variant 2, without any additional software and without reconstructing 
the logic scheme of the network. It is realized with the application of an opportunity of creation 
of the network bridge between two network cards in MS Windows 2003 and MS Windows XP 
operation systems. 
To create the bridge do the following: 

• Choose a computer from your network with MS Windows 2003 or MS Windows XP 
operation system where the “Internet Administrator” will work.  

• Install the second network card into the computer. 
• Take the network cable from a hardware router the the network switch and connect it 

to a new network card.  
• In the properties of a network environment choose two network cards and in the 

menu by clicking the right mouse button specify Bridge Connections.  
• Set IP address and other TCP/IP parameters that the first network card had to the 

created bridge.  
• Check the Internet from the given computer and from other workstations.  
• Take into account that if the given computer will be shutdown, other workstations will 

not get access to the Internet.  
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Section 2.3. - Installation of the server part 
 
To begin installation run the distribution kit of the “Internet Administrator" server part. 

During the installation you will pass some steps where you will be offered to enter the 
necessary data or to familiarize with the information. 

   
Step 1 -The license agreement 

Familiarize with the contents of the license agreement which regulates the order of use of the 
software and the responsibility of the manufacturer and the user. For continuation of 
installation you need to accept the conditions of the license agreement, by pressed the button 
"Agree". 
   

Step 2 - Enter the activation key 
If you have purchased a copy of the “Internet Administrator" software at this stage you should 
enter the activation key which can be found on the card inside the product box. If you install a 
trial version of “Internet Administrator" it is not necessary to enter the key. However in this 
case “Internet Administrator" will work 15 days from the moment of installation then the 
service will no longer be started. You can enter the activation key at any time after the 
installation by means of the administrative utility “Users Administrator". 
   

Step 3 - Choice of the installation folder 
Choose the folder to which you wish to install the "Internet Administrator". By default the 
installer will suggest you to install the program the Internet Administrator subdirectory of the 
Windows Program Files folder, for example, C: \Program Files \Internet Administrator. 
   

Step 4 - Copying of files, registration of components 
At this stage the installer copies all necessary files to the system folder and the "Internet 
Administrator" folder, registers libraries and DCOM components, installs the driver and 
system service “Iadmin server". 
   

Step 5 - Enter a pool of local IP addresses 
In order for the "Internet Administrator" system to correctly register and analyze the Internet 
traffic, it is necessary to specify the computers belonging to your local network which should 
be monitored. For this purpose it is necessary to enter subnet addresses and masks in 
accordance with TCP/IP rules which define your local network. You can change these setups 
after the installation by means of the “Users Administrator" utility. 
   

Step 6 - Choice of the network card for binding  
You should choose the network card. The "Internet Administrator" will monitor traffic which is 
passing only through one network segment to which the chosen network card is connected. 
For example, if one network card is connected to an external network (Internet), and another - 
to the internal network  then a network card working with an internal network should be 
chosen in order to be able to monitor the Internet activity of each workstation. 
   

Step 7 - Attempt to start the services  
At a finishing seventh stage the installer makes an attempt to start the network driver and 
service. In most cases the start is done successfully, and you can begin to work with the 
system right after the start provided that you have specified the necessary parameters of the 
network. However sometimes it is impossible to start the system without rebooting the 
computer. The service is installed in the automatic start mode, therefore after rebooting the 
computer you can immediately work with the system. 
 
If the installer finds out the previous version of the complex, it will ask to remove it before the 
next installation. Thus you can save the database Iadmin.mdb with the information and then 
replace it after the new installation. If you use a database on MS SQL Server after installation 
you will use the "Database Wizard" for the choice of the working base. 
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Note. If proxy server is used in your network its internal IP address used for inquiries of 
clients, will get into the segment of local addresses. Such address has be made external by 
means of the "Users Administrator" administrative utility. Choose Service->Options in the 
menu. On the Network settings page enter the internal IP address of a proxy server in order to 
exclude it from local addresses. After these changes it is necessary to restart the ‘Iadmin 
server’ service. 

After the installation the "Internet Administrator" begins to work in a static 
identification mode, and automatically finds the users and workstations. 

 
 

Section 2.4. - Installation of the client part 
 
The Client part of the "Internet Administrator" is an optional component and is installed on 
each of the user computers. 
   
For the beginning of installation of the program start the distribution kit of the client part of  the 
"Internet Administrator", received on the compact disc or downloaded from the Internet. 
During the installation you will need to accept the conditions of the license agreement, and 
also to enter a name or IP address of a computer on which the server part of the "Internet 
Administrator" is installed. 
   
Note: installing the client part on Windows 98, make sure that the package of updating of 
means DCOM is installed on the computer. If you are not sure, update Windows before 
installation, by starting the dcom98.exe file from Patches folder of the compact disc. You can 
also download the file for update from the site http://www.iadmin.biz inform the Downloads 
section. In case DCOM is not updated up to version 1.3 the Client cannot work on the given 
computer. 
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SECTION 3 - SETUP OF THE SYSTEM 
Setup of the system is done by means of the "Users Administrator" administrative utility. 
 
Section 3.1. - Setup of network parameters 
 

The "Internet Administrator" system has two parameters directly influencing its work. 
They are the network card to which the service is attached and the list of local addresses of 
the internal segment. When these parameters are set incorrectly, the system will also work 
wrong.  

Attachment to the network card is carried out in the menu Service-> Select network 
card. In the appeared window the current network card together with its IP address, as well as 
the drop-down list of the network cards installed on the  computer will be displayed. After the 
choice of adapter it is necessary to restart the Iadmin server service. Attachment has to be 
done to the adapter through the network segment of which the Internet traffic from 
workstations passes. If you have two network adapters attachment is has to be done to the 
internal adapter connected to the local network.  

Setup of local addresses is done in the menu Service-> Options at the Network 
settings property page. Addresses of local subnets define a set of IP addresses which you 
use in your internal network. Addresses are set in the mode of network address (not a host!) 
and a subnet mask. You can set up to 10 various network segments. The addresses excluded 
from the local ones, are considered external, that is Internet addresses. Any inquiry to such 
addresses will be considered as an access to the Internet. The purpose of such addresses is 
necessary when a proxy server is used in your network. Its internal IP address needs to be 
added to the list of excluded IP addresses.  

 
Section 3.2. - Setup of the type of user identification 
 

Setup is made in the menu Service-> Options on the Modes property page.  
The "Internet Administrator" supports three types of user identification on workstations: 

static, by logon into MS Active Directory and by username and password.  
In case of the static type of identification (it is set by default) users are identified on the 

workstations rigidly. Each user corresponds to that workstation on which he has been found 
for the first time.  

In case of the type of identification by logon into MS Active Directory the user is 
identified on the workstation only after the logon to the Windows domain controller. When the 
logon of the user is done locally, he is not identified on the workstation and access to the 
Internet from this workstation will be denied.  

The type of identification by user name and password provides an input of these data 
for identification. If the user is not identified on a workstation, access to the Internet from this 
workstation is denied.  

Installation of a client part is necessary for the last two types of user identification on 
the workstations. Identification of one user on two and more workstations is not possible. 
Thus the user is identified on the last workstation where he was registered; the previous 
workstation is released.  

 
Section 3.3. - Setup of monitored ports 
 

Setup is made in the menu Service-> Options on the Modes property page.  
Monitored ports define with what ports (Internet protocols) the "Internet Administrator" will 
work, i.e. it monitors traffic, limits resources and manages the internet access. Monitored 
ports are first of all intended for work with a proxy server. Since it is necessary to exclude the 
proxy server  from the local segment, all inquiries to it will be considered as inquiries in the 
Internet. If other network applications are installed on the proxy server the ports on which 
these applications work will have to be added to the list of not monitored ports. If the proxy 
server gives access on the limited set of ports (HTTP, FTP, POP3, and SMTP), they are 
adjusted so that monitoring is conducted only on them, and the others are not taken into the 
account.  
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Section 3.4. – Setup of HTTP protocol detection 
 

 Setup is done in the menu Service-> Options on the Modes property page.  
This setup defines, how the detection of inquiries on the HTTP protocol will be carried 

out. There are four types of detection:  
Detect access to web site only. Inquiries of users only to the home page of a site will be 

registered. Other pages and files of the given site are not registered.  
Detect access to web site and page extensions. At such setup inquiries to the home 

page of a site and also to the set page extensions and files are registered. Pages and files 
are set as per their extensions, for example, .html or .zip. For the task of extensions press 
button "Page extensions" and in the appeared window enter the necessary extensions. All 
other, not set pages and inquiries as a separate element of access will not be registered.  

Detect all, except page extensions. Here, unlike the previous mode, you set the 
extensions of files which do not need to be registered. It is made in order not to register 
numerous pictures (.gif, .jpeg) at the opening of a page as they do not represent any special 
interest.  

Detect all requests. Any inquiries under HTTP protocol are registered. This setup is not 
recommended, as the database in this case is very quickly filled.  

 
Section 3.5. - Additional setup 
 

Setup is made in the menu Service-> Options on the Miscellaneous property page.  
Database update period. The "Internet Administrator" operates with data in operative 
memory. Periodically it writes down data to a database. By default value of the period of 
updating is equal to 20 seconds. For more operative tracking it can be reduced. It is not 
recommended to establish this parameter of less than 5 seconds. In case of a lot of users this 
parameter can be increased to decrease the load of the processor. Then updating will occur 
less often.  
Time-out of user activity. This parameter defines an interval during which calculation of time 
spent by the user in the Internet and on any site, is carried out though the user in this case 
does not send any inquiries in the Internet. After the expiration of a time-out period the 
"Internet Administrator" considers, that the user is not active. The time-out helps to trace 
operating time more precisely. The user can load some pages and look them through for 
some time. In this case there will not be any activity from it, but by means of the time-out the 
calculation of time will be conducted.  
Enable control of IP - MAC addresses change. This parameter is intended for protection 
against the change of IP address on a workstation i.e. when the user changes his own IP 
address to an IP address of another user to use his resources. In case of detection of such 
substitution any inquiries from a workstation to the Internet will be denied.  
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SECTION 4 - MANAGEMENT OF USER RESOURCES 
 
This section describes the methods of management of user resources. All setup given in this 
section are carried out from the "Users Administrator" administrative utility. 
 
Section 4.1. - "Users Administrator" 
 

The "Users Administrator" is the basic administrative means of the “Internet 
Administrator”. Here all system setup is carried out, output of the statistical information and 
reports, administration of the system, management of user resources are done.  

In the main window three lists are presented: users, groups and workstations. The 
information in the given lists can be updated by means of the menu View->Refresh, buttons 
on the toolbar or F5 key. 

Users.  
This list the gives brief information on the user: system name of the user, full name of 

the user, his description, the information, on what workstation he is currently identified, and 
whether the user currently has access to the Internet. Users can be sorted on the basis of a 
system or full name by means of the menu View->Sort users. Search of users on their system 
name is stipulated. For this purpose enter the first letters of a system name into a line on the 
toolbar, the index in the list of users will pass to users corresponding inquiry. From menu 
"User" or from menu by clicking the right mouse button it is possible to see properties of the 
user, to change his group, to remove or add the user, to change his system name, and also to 
see user statistics and access log. About the two last opportunities see section 6 "Additional 
opportunities of "Users Administrator".  

In properties of the user four property pages are displayed. On property page "User 
properties" it is possible to change a full name of the user and his description, to see the 
information on a workstation on which the user is currently identified. Here it is possible to 
block the user manually - thus the access to the Internet for him will be compulsorily denied. It 
is possible to unblock the user who is blocked manually. If the user is blocked by the system, 
he needs to fill up the limit, or to increase it. Here too it is possible to change the group, to 
identify the user on a workstation and to see user statistics. Manual identification is necessary 
only at casual removal of the user and its creation again, or at changes from identification 
modes from “by logon into MS Active Directory” or “by username and password” back in the 
mode of static identification. On the property page "Traffic and time limits" and "Traffic 
bandwidth" restrictions of user resources are set. Property page “Authentication” is intended 
for the purpose of a username and password for registration in the "Internet Administrator". 
The name and the password are necessary for the identification of a user on a workstation.  

Change of group will allow moving the user to another group. In the opened window 
you need to choose group and press “OK”. Thus all restrictions of a group will pass to the 
given user. Originally all users are in the System group. The users who do not belong to other 
groups are members of this group. All new found users are added to the System group.  

Removal of the user will lead to the removal of the user object and all information 
associated with it.  

Creation of the user is necessary only at casual removal of the user in a static 
identification mode or in the identification mode by the username and password for creation of 
a new user logon account to access to the Internet. At any actions with creation or removal of 
users it is necessary to restart service "Iadmin server".  

Change of a system name can be made for the convenience of display in reports. The 
system name is the name of the user defined by the system at detection of a workstation. It 
can be a domain user name, a name of a computer, or IP address if it was not possible to 
resolve a name. At the identification mode by logon into MS Active Directory the  change of 
system names is impossible, as in such mode they are domain names, and there is a 
comparison of the logged user to them. 

Groups.  
Object “the group” unites some users. Any actions with the group concern all users 

belonging to it at the present moment. By means of the menu "Group" or the menu by clicking 
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the right mouse button it is possible to see properties of group, to create, rename or remove a 
group. The name of group is unique. It is impossible to rename or remove the system group.  

In Group properties two property pages are displayed. On property page "Group 
properties" its name, description, and also users belonging to it are displayed. From here it is 
possible to delete and add member users. When the user is added he is deleted from the 
group of the previous membership. At removal he becomes a member of the System group. 
The user cannot be a member of two and more groups. On a given property page it is 
possible to block the group compulsorily. Thus access to all users of this group will be denied. 
On property page "Traffic" restrictions on the volume of the incoming traffic from the Internet 
are set.  

By default all users at detection are put to the System group. It is convenient for using, 
if you wish to block all new found users automatically. For this purpose distribute all users to 
other groups and block the System group. The new user at detection will get in this group and 
access to the Internet for him will be denied. 

Workstations.  
In the given list the found out workstations of your network are all reflected. Here the 

information on a name of a workstation, its IP and MAC addresses, and also about the user 
who logged on is presented. By means of the menu "Workstation" the workstation can be 
moved to the list of unmonitored workstations. Thus all inquiries from these workstations will 
not be registered by the system. In the menu by the right mouse button it is possible to 
remove the workstation or see its properties.  

In workstation properties you can write down its description, and also change its 
registration data, such as the Name, IP address and MAC address. The last one is necessary 
only in the worst extremity.  

 
 

 
Section 4.2. - Limitation of the incoming traffic and operating time in the Internet 
 

Restriction of the incoming traffic and operating time is done in the properties of the 
user on property page "Traffic and Time limits". In order to make functions of restriction work it 
is necessary include them by corresponding check boxes. Then, by means of button 
"Set/Change" the time period and a limit is set.  

The time period is the time during which restriction is in force. When the limit is over the 
user is blocked. At transition in the following interval of time period, data about the end are 
cleared. If the user has been blocked by the system access to him opens. The limit of the 
traffic is set in megabytes, of the time - in hours.  

There is an opportunity to fill up the prematurely ended limit. For this purpose in section 
"Limit Additions" press button "Add" and set the corresponding size. Yet not used addition of a 
limit can be removed by button "Remove", not ended addition - to close button "Close". Thus 
access to the user in the Internet is denied. Addition can be entered before the end of the 
basic limit or before the end of the previous entered addition. Additions concern and operate 
only in the current time period.  

Restrictions on the traffic and time can be set for several users simultaneously. For this 
purpose in the basic window you need to choose some users, using keys Ctrl and Shift, and 
having called by the right button of the mouse the drop-out menu, choose “Set multiple limits". 
Set restrictions in the appeared window.  

To limit the traffic it is possible also for a group of users. For this purpose in group 
properties choose property page "Traffic" and set the necessary parameters. Work of each 
user of group will influence end of the limit, even one user can become the reason of end. At 
the end of the limit the group and all its users are blocked.  
 
Section 4.3. – Traffic bandwidth limitation 
 

For restriction of bandwidth open user properties and choose property page "Traffic 
bandwidth". Here it is possible to set the maximal and guaranteed speed of loading of data 
from the Internet. Speed is set in kilobytes per second.  

The Maximal speed defines speed limit of loading of data by the user. Application of 
this parameter does not depend neither on current speed of the whole channel, nor from the 
current speed of work of the user. It is rigidly attributed to a workstation and under no 
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circumstances the speed of loading from the Internet by the given user cannot exceed the set 
maximal speed.  

The Guaranteed speed can be necessary for some users of your network. The given 
function will provide the set guaranteed speed of loading of data from the Internet. The 
guaranteed speed can be set both together, and separately from the maximal one. In case of 
normal work of the Internet channel when its throughput suffices for processing all inquiries, 
only the mechanism of restriction of the maximal speed works. At an overload of the channel 
and simultaneous decrease in speed of loading the guaranteed users have less, than their 
guaranteed speed, joins the mechanism of the guaranteed speed. The mechanism tries to 
approximate as much as possible the speed of loading of the guaranteed users to their set 
guaranteed speed. Thus the maximal speed of users for whom the guaranteed speed is not 
set dynamically decreases or speed of loading decreases even if the maximal speed is not 
set. The minimal speed for such users is 1 kilobyte per second. If the channel remains and in 
this situation is loaded, there is a proportional reduction of speed at the guaranteed users not 
to give an advantage to somebody from them, and to enable them to work with the priority 
proportional to their set guaranteed speed.  

For work of the mechanism of restriction of throughput installation of the client for the 
"Internet Administrator" on workstations of users is required. If you do not plan to use the 
mechanism of the guaranteed speed, the client part can be installed only on those 
workstations for which the maximal restriction is planned. In case of use of the mechanism of 
the guaranteed speed absence of a client part on several workstations is critical. The given 
mechanism at an overload of the channel cannot limit workstations where the client part is not 
installed.  
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SECTION 5 - INTERNET ACCESS MANAGEMENT 
 
This section describes the methods of Internet access management. All the setup given in 
this section is carried out from the administrative utility "Rules Administrator". In the main 
window of “Rules Administrator" the list tree of Internet resources, and also the list of users 
and groups are displayed. 
 
Section 5.1. - System of rules 
 

The System of rules defines the access policy - who, when where and how can get 
access to the Internet. Rules work on a priority from top to bottom, the highest priority has the 
latest rule under the list. There are two types of rules - granting access or denying it. In case 
of absence of rules, access is granted to all internet resources for all. 

Creating a rule is possible from the menu of "Rule", from the right button mouse menu, 
or having dragged any object by mouse to a free place from the current rules in the list of 
rules. The new rule by default grants access to all internet resources for all.  

Adding objects to rules works by a principle Drag & Drop. You simply drag the 
necessary object and drop it on the necessary rule, or on free area. After any changes in 
rules, it is necessary to accept these changes on a “Internet Administrator” server. For this 
purpose use the button "Accept changes" on the toolbar, or the "Rule" menu.  

By means of the menu or twice having cluck by a rule, you can see its properties. Here 
it is possible to change the type of a rule, to write the comment, to see and remove current 
objects of a rule. Also it is possible to see properties of internet resources.  

 
Section 5.2. - As rules work 
 

Rules work under the list from top to bottom. The rule with most priority is the last one. 
The system searches all over again for the denying rule and objects in it, and then further 
under the list granting. If the granting rule on the given resource is not revealed, access is 
denied.  

For example, in the first rule you have denied access for HTTP protocol. In the second 
rule under the list you have granted access to site www.midomen.com - without the instruction 
of additional objects. At such scheme access via HTTP will be granted only to the given site.  
 
Section 5.3. – Rule objects 

 
There are two types of rule objects – Internet resources and users with groups. If in one 

rule different objects are stored their action is imposed against each other and the general 
condition of a rule changes. For example, if in one rule you deny the certain site, the protocol 
and access time to this site will be denied only under the given protocol and only at the 
appointed time. Unlike the aforesaid categories of sites are united only with access time.  

Users and groups define, to whom the given rule is applied. The list of users and 
groups corresponds to lists in the utility “Users Administrator". There is a fast search of users 
and groups. For this purpose enter the first letters of a name into the search string.  

Internet resources are objects, or parameters of the Internet access. There are seven 
various Internet resources. Addition of resources to the corresponding list is carried out by 
means of the right button mouse menu. In the given menu also it is possible to see properties 
of a resource and to remove it.  
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Categories.  
In the list 37 standard categories are presented. Addition of the user categories is 

provided also. In such categories the manager himself adds the necessary sites.  
Domains names.  
In this list it is possible to add any domains, the first, the second and third levels. 

Presence of the domain at a rule means presence of all known hosts of the given domain, 
and also hosts of all sub domains of any level.  

Internet sites.  
Here there are two lists of sites - detected and user defined. The detected sites are 

caught by system automatically at the user inquiries. The user defined sites are added by the 
manager manually. Thus the name and IP addresses of a site are entered. IP addresses can 
be resolved using the Domain name system. For this purpose press the button "Get IP 
addresses through DNS" in a window of site addition.  

Subnets.  
This resource defines a set of Internet sites by IP addresses. Addresses are set in the 

form of Subnet address and the mask.  
Protocols.  
Protocols comprise the list of TCP/IP ports on which data transmission between a 

workstation and sites is carried out. By default in this resource the list from standard protocols 
is included. 

URL parts.  
The given resource defines words in the inquiries of the user. Inquiries to Web and FTP 

servers are registered. Inquiry that the user has entered after the name of site is taken into 
the account. Here it is also possible to specify the extensions of pages and files (for example, 
".exe" and without asterisks).  

Access time.  
The given parameter defines an interval of time, in which the user can get (or not get) 

access to certain resources. Access time is set in days of the week and time of day of week.  
 
Section 5.4. – Category database 
 
Since version 2.1 the category database is included into the complex. All sites are divided into 
37 categories. This innovation is an essential step for the convenience of management of 
access to the Internet. Now the manager does not need to enter the certain sites into the list, 
and it is enough to set the necessary category. You can test a site for its presence in the 
category. For this purpose choose the menu of the Categories-> Test a site. There is an 
opportunity to not only add a site to the user category, but also to define to it one of the 
standard categories. It can be made in the administrative utility "Users Administrator" in the 
internet access log. Double click on site and set the necessary category to it. The category 
can be set, if the site does not belong to another category. The list of sites with the categories 
set manually is in the menu of the Category-> User sites. Here it is possible to change a 
category of a site, and also to set a category "None". Thus the site in the future will not have a 
category. All the actions concerned with the manual change of categories demand a restart of 
“Iadmin server” service.  
 
The List of categories in database: 
  

Category Description 
Sport Sports sites  
Auto/Moto The Sites, devoted to cars and to wheel technics  
Games Game sites, on-line games  
Entertainment/Humor Entertaining sites, except for games. Everything where it is 

possible to have a good rest - theatres, cinema, restaurants, 
etc.  

Job Search Sites intended for job search  
Travel Travel, trips across the world, sites of travel companies  
Goods/Services Includes sites of the companies, rendering services and 

delivering consumer goods  
Streaming Media/MP3 On these sites it is possible to download music in MP3format 
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or view online video. 
Military/Weapons Military sites  
Business/Economy Economy, financial news and analytics  
Education Sites of institutes, scientific research institute and others 

educational organizations  
Health/Medicine Medicine and health, pharmaceutics  
News/Media Public mass media 
Industry/Manufacturing The heavy industry, metallurgy, machine tools and so forth  
Computers/Internet Sites of the companies working in the field of IT, and also 

sites with any information about the Internet and computers 
Web based Email Free-of-charge mail in the Internet through a web browser  
Free hosting On such sites it is possible to place your own site free of 

charge  
Search Engines Search Engines 
Adult/Mature/Porno Pornography and adult sites  
Criminal Criminal 
Hacking Hacking sites  
Rligion/Horoscop/Magic Religion, magic, horoscopes  
Chat/Instant Messaging Various chats, IRC systems, ICQ  
Government/Law/Politic Official web sites of official bodies, political parties, legal 

profession and jurisprudence 
Kids/School/Family Sites for children, made by children, sites of schools and for 

school children  
Culture Museums, cultural state institutions, art  
Advertisement/Banners Advertisement banner networks  
Alcohol/Tobacco Sites of manufacturers of alcohol and tobacco, and also the 

sites calling for their use.  
Illegal/Questionable Immoral, illegal, roguish and other dangerous sites  
Gambling On-line gambling for money  
Hate/Racism Sites devoted to racial discriminations, enmity between 

people, to violence.  
Illegal Drugs Propaganda of drugs  
Web Communications Dialogue on the Internet by means of forums  
Reference Reference 
Sex Education Sexual formation, here there is no pornography  
Software Downloads Software archives  
Money for surfing Sites offering money for surfing, a freebie, etc.  
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SECTION 6 - ADDITIONAL FUNCTIONS OF THE "USERS 
ADMINISTRATOR" 
 
Section 6.1. - Statistics of access 

The Statistics of access combines traffic and time statistics and the internet access log. 
The statistics can be seen in the right mouse button menu, having chosen the user. 

The traffic and time statistics displays data about the traffic and time according to the 
chosen registration period: how much is used, how much is set, how much remains and the 
date of transition in a new interval of the time period. Here too it is possible to see the 
incoming traffic of the user and operating time in the Internet for a current day. 

The Internet access log shows, to what resources the user has access. Here the name 
of a site to which the user has access, its category, inquiry, protocol, time of access, and also 
the volume of the downloaded sent data and duration of the reference is displayed. If access 
to the given resource has been denied, it is highlighted with red color. There is a filter by date 
of and time for the instruction of an interval of a conclusion of data. It is possible to display 
data for a day, last week, month, or to set any interval. The last value of the filter is kept. 

 
Section 6.2. - Licensing 

You can use the “Internet Administrator" without a license activation key for 15 days 
from the moment of the first installation. If you purchase of the product you receive a license 
activation key which is necessary for entering for the further work. Input of a key is carried out 
in the menu "Service-> License activation". If the key is entered correctly, you will see the 
quantity of workstations on which the license is calculated. Press “OK” to save the key in 
memory. 

 
Section 6.3. - Unmonitored workstations 
 

By default all workstations are monitored and are present at the list of workstations of 
the main window. Sometimes there is a necessity not to apply an access policy for some 
workstations or servers of a network. For example, the mail server for sending messages 
uses port 25. If this port is blocked by an access policy the server cannot send mail. For 
unmonitored workstations access is not registered, and no restrictions are applied. 

Moving of a workstation to the unmonitored list is done from the menu "Workstation". 
Before that it needs to be chosen. In the same place in the menu it is possible to open the list 
of unmonitored workstations. From here it is possible to move a workstation back to the 
monitored list. 

If the license key is entered and their quantity is equal the list of workstations to 
quantity of workstations of the license all new workstations will be added to the unmonitored 
list. If at the moment of input of a license key the number of monitored workstations exceeds 
the number provided by the license the part of such workstations needs to be moved to the 
unmonitored list. “Internet Administrator” will trace only that number of workstations that is 
provided by the license even if in the list of monitored workstations their number is more. In 
this case it will be difficult to tell, which workstations are monitored, and which are not. 
  
Section 6.4. - Purge database 
 

For reduction of the size of a database by the physical carrier you can remove the out-
of-date information from it. In the menu "Service" choose "Purge database”. You can remove 
the information with users and workstations, or to specify a time interval. It is possible to keep 
the information for a day, for the last week, month, or to specify an interval manually. 
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SECTION 7 – REPORTS CREATION 
 
The “Internet Administrator” gives sufficient opportunities in the field of formation of the 
reports reflecting dynamics of use of the Internet in your organization. 
 
Section 7.1. – Report creation 
 

For opening a window of a reports creation you can take advantage of the tool bar or 
choose item "Reports" in the menu "Service". You can choose the report that interests you, 
and also to adjust the report by means of the filter of objects. Apart from the filter of objects 
there is an opportunity to specify the certain interval of time for which the report is created. 
 
Section 7.2. - Setup of reports 
 
You can adjust reports under the following characteristics: 

• Users, the information about which will be used; 
• Groups of users, the information about which will be used; 
• Time period for which the information on the internet access will be used; You can 

specify the following time periods: for all time, for today, for a current week or month, 
and also having set an interval manually. 

• Protocols; 
• Categories; 
• Sites. 

 
Section 7.3. - Available reports 
 

Report Description 
General traffic usage by 
users 

Report representing the information on the volume of 
downloaded and sent data for each user 

General traffic usage by 
groups 

Report representing the information on the volume of 
downloaded and sent data for groups 

Traffic usage per day The summary traffic on days which has been spent in your 
network. This report will help to spend to you verifications 
with the provider. 

Top 10 active users by traffic Ten most active users as per the volume of the 
downloaded and sent data 

Detail traffic usage by users Report representing the information detailed on days on 
the charge of the incoming and outgoing traffic 

General operating time in the 
Internet by users 

Report represents a brief information on the time spent in 
the Internet by each user 

Top 10 active users by  
operating time in the Internet 

Ten most active users as per operating time in the Internet 

Detail operating time in the 
Internet by users 

Report representing the information detailed on days on 
an operating time in the Internet 

Site access by connection Report represents the list of the visited sites with number 
of references and date of last visit 

Top 10 sites Ten the most visited sites by the quantity of references 
and on volume of the downloaded data 

User activity by sites Report shows the sites which were visited by each user, 
with the quantity references and other statistical 
information 

Detail user activity by sites Report represents the expanded information on access of 
users to sites inquiries to each site. 

Site activity by users Report represents sites and for each of them the inquiries, 
accessed by the users. 

Category access by 
connections 

The list of categories with the information about the 
quantity of visits and the traffic. 

Top 10 categories The Graphic report on ten the most active categories on 
the traffic and inquiries. 
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SECTION 8 – DATABASE and Microsoft SQL server SUPPORT 
 
The Database of the “Internet Administrator” is the basic storehouse of the information. Data 
about activity of users, rules and other adjustments are stored.  
 
Section 8.1. – Default database 
 

After the installation the "Internet Administrator" starts to work with a database in MS 
Access format. The file of database refers to "iadmin.mdb", ODBC data source - "iadmin". 
Database can arrange in other place which is distinct from the installation folder, for example, 
on other disk. Thus it is necessary to copy a file and to change a way to a data source. 
Service and all administrative utilities thus should be unloaded from memory of a computer.  

MS Access database is not intended for a large volume of data. When its size is more 
than 1 gigabyte the work of the program significantly slows down. MS Access database needs 
to be cleaned from the out-of-date information. If the number of users of a network is more 
than 50 it is recommended to use Microsoft SQL Server as a database management system.  

 
Section 8.2. – Database on Microsoft SQL Server 
 

"Internet Administrator" can use Microsoft SQL server versions 2000 or higher as a 
database management system. This DBMS is intended for databases of scale of the 
enterprise and supports databases with a large volume of data. To use MS SQL Server one 
client license is enough.  

The special utility is included in the "Internet Administrator" - "Database Wizard". By 
means of this utility, it is possible to create a database on MS SQL server, to import data from 
MS Access to SQL Server, and also to choose, what DBMS should be used in the future. 
When the "Database Wizard" is used it is necessary to stop ‘Iadmin server’ service and to 
close all “Internet Administrator” applications.  

Creation of a database on MS SQL Server  
1. Create the user on the server. Set English as the default language. On 
property page “Server Roles” give the user the Database Creators role so he 
could create databases on the server. These requirements are obligatory for a 
normal work of the "Internet Administrator".  
2. Start “Database Wizard" and choose "Create database". On the following 
screen specify a name of ODBC data source (any name - it will be created), a 
name of a server, a name and the password of the created user. By pressing 
the "Finish" button the master will carry out an attempt of creation of database 
and will inform on the result. In case of successful end the complex will begin 
work with the database of the MS SQL server.  

Import data from MS Access to MS SQL Server  
Start "Database Wizard" and to choose "Data import". Specify a path to a file of 
the MS Access database, name of MS SQL Server and the name and the 
password of the user on behalf of which the database was created. After 
pressing the "Finish" Button data import which, depending on the volume, can 
last longer than one hour will begin. The indicator will show the percentage of 
import. When data import is happening the information from database on MS 
SQL Server will be removed, therefore it is recommended to do this operation 
at once after database creation.  

Change database location 
In the future you can go back to MS Access database or database on MS SQL 
server. For this purpose in "Database Wizard" choose “Change database 
location", then specify the type of a database and ODBC data source which 
refers to it.  
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Section 8.3. – Backing up 
 

For the safety of the data collected by the “Internet Administrator” in case of failure of a 
computer is recommended to do backup copies of the database. If you use MS Access 
database, simply copy the file of a database iadmin.mdb and archive it. If the database is be 
on MS SQL Server, backup copying is carried out by means of the DBMS itself. For additional 
information, address to the documentation on MS SQL server.  
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SECTION 9 - DISTRIBUTED NETWORKS 
 
“Internet Administrator” includes means for construction of the uniform scheme of monitoring 
and management of an access policy to the Internet at the enterprises with the distributed 
networks. It is provided by creation of the central database and installation of copy of a 
“Internet Administrator” in each of controlled networks. The distributed networks are meant as 
the networks which are in different buildings and have different Internet connections, and the 
networks geographically separated from each other incorporated by VPN channels (Virtual 
Private Networks).  
 
Section 9.1. - Creation of the central storehouse of data 

For creation of the central storehouse of the information of the “Internet Administrator” it 
is necessary to carry out the first installation in the central network and to transfer a database 
of a complex on Microsoft SQL server (see section 8). The information will be stored on a 
given DBMS. 

 
Section 9.2. - Setup of a complex in additional networks 
 

Install the “Internet Administrator” in the remote network under the usual scheme, stop 
‘Iadmin server’ service. Access will be necessary for the connection to the database on MS 
SQL Server in the central network - on VPN or to other network connection. Create an ODBC 
data source (Administrative Tools-> ODBC data sources) of type MS SQL server. Thus 
specify the name of a server with MS SQL in the central network (or its ip address), check the 
authenticity of user SQL server, and make sure that you set - use "iadmin" database by 
default. This is the database where the information is stored refers to. Test the source of data 
before creation. After that, by means of the utility "Database Wizard", change an arrangement 
of a database and choose the created data source. Set name and the password which have 
been entered at creation of a database in the central network. Start service ‘Iadmin server’. If 
the service was started without errors, this means that connection with the central database 
has passed successfully.  

Note! In the additional networks there should be different IP addressing. I.e. there 
should not be two computers with identical IP addresses, IP networks should not 
cross. If this occurs, the traffic from other workstations with the same IP address 
which is set on its workstation will be added to one user. 

 
 
 

Section 9.3. - Management and administration 
After creation of the uniform scheme to operate an access policy, and also to look 

through statistics and to create reports it is possible from any network. But for normal work 
from a place of administration it is necessary to have communication with all servers through 
DCOM under RPC protocol. It is desirable not to filter the traffic on VPN channels as RPC 
always uses dynamic ports. Also it is necessary to adjust the names resolution of servers 
where the “Internet Administrator” is installed. It is better to use for this purpose file ‘hosts’ 
(\windows \system32 \drivers \etc). Set there ip addresses of the servers and their names of 
computers as they refer to actually.  

At realization of some actions in administrative utilities, say, blocking of the user, fixing 
of changes in rules, etc. communication occurs with the “Internet Administrator” server. In 
case such communication cannot be established, changes will occur only in the database, 
and the server will apply them only after restarting of ‘Iadmin server’ services.  
 

http://www.iadmin.biz
mailto:sales@iadmin.biz


Internet Administrator, version 2.6 
 

Copyright  2003 Internet Administrator Company Ltd. 
http://www.iadmin.biz, e-mail: sales@iadmin.biz 

 - 22 - 

SECTION 10 - CLIENT FOR "INTERNET ADMINISTRATOR" 
Client part of the complex is the additional module necessary for work of the following 
functions: 

•  Output user statistics. Shows statistics on the traffic and on time restrictions with the 
limit, its usage and the rest accessible to use. Data about throughput are displayed: 
current speed, the maximal and guaranteed speed. 

• Bandwidth limitation. This restriction occurs at the client level. For this purpose the 
system component working at a level of operation system is used. In addition to the 
general restriction of speed of the computer, proportional restriction of speed of work 
of each active application is carried out. Total speed of each application makes the 
maximal speed for the given user.  

• User identification. In the identification mode on the logon into the MS Active 
Directory the client detects the current user and transfers data to a server where 
identification of the given user to a workstation takes place. In the identification mode 
by username and password the principle of work is similar, only the user is registered 
on a “Internet Administrator” server after network logon. 

The Client part is installed on workstations. For installation it is necessary to start the 
distribution kit downloaded from the Internet or received on a compact disk. During installation 
enter a name or an IP address of a computer on which the “Internet Administrator” server is 
installed. 

The Client part includes the module which works at the level of the operation system. 
This module can be not compatible to the foreign software. Thus there will be faulty 
operation. 
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